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Chapter 1. System requirements and compatibility

IBM® Campaign is part of the IBM EMM suite of products. Campaign version 9.0.0
requires Marketing Platform 9.0.0.

For best results, set your screen resolution to 1440 x 900 or higher. Lower
resolutions can result in some information not being properly displayed. If you use
a lower resolution, maximize the browser window to see more content.

Where to find complete system requirement and compatibility
information

For a list of IBM EMM product versions compatible with this product and a list of
third-party requirements for this product, see the Recommended Software
Environments and Minimum System Requirements document. This document is posted
under Detailed System Requirements on the IBM Support Portal website:
(http://support.ibm.com).

Note: To access the IBM EMM documentation from the Support Portal, you must
log in with an IBM account. This account must be linked to your IBM customer
number. To learn more about associating your account with your IBM customer
number, see Support Resources > Entitled Software Support on the Support
Portal.

You can also access this document by selecting Help > Product documentation
when you are logged in to IBM EMM.

Installation and upgrade

You can upgrade to Campaign 9.0.0 (including eMessage) from version 8.5.x.x or
8.6.x.x only. If you have a prior version of Campaign or eMessage, follow the
upgrade paths that are listed in the Campaign upgrade scenarios topic in the IBM
Campaign Installation Guide.

The default top-level directory for IBM EMM installations is /IBM/EMM (for UNIX)
or C:\IBM\EMM (for Windows). The product installers place product files in
individual subdirectories under the EMM directory. For more information, see the
IBM Campaign Installation Guide.

The response file of each product installer now includes the version number.

Using Campaign with multiple browser windows
To use multiple browser windows with IBM Campaign 9.0.0, you must use File >
New Session to open additional Internet Explorer windows.

Internet Explorer 9.0 (32-bit) on Windows Vista or Windows 7 clients is the only
supported browser for IBM Campaign 9.0.0 flowcharts.

If you want to log in to IBM Campaign multiple times to view side-by-side
information, you must use the following method to open multiple browser
sessions.
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Important: Do not use any other method to open multiple browser sessions. For
example, do not use a new tab in Internet Explorer; do not open another browser
session from the Start menu or desktop icon; and do not use File > New Window
in Internet Explorer. If you use these methods, IBM Campaign treats the new
browser instance as the same browser session. Use of these methods can confuse or
corrupt information that is shown in the application.
1. Open Internet Explorer 9 from the Start menu or desktop icon.
2. Log in to IBM Campaign.
3. In the browser window that you opened in Step 1, select File > New Session in

the Internet Explorer menu bar.
A new Internet Explorer instance opens.

4. In the new browser window, log in to Campaign as the same or different user.

Remember: You must disable any pop-up blockers in your browser or browser
add-ons, such as toolbars. Pop-up blockers prevent the flowchart window from
opening.

2 IBM Campaign: Release Notes



Chapter 2. New features and changes in IBM Campaign v9.0.0

IBM Campaign version 9.0.0 includes the following new features and changes.

Branding

The Unica® name is no longer used. For example, IBM Unica Campaign was
renamed IBM Campaign.

IBM Coremetrics was renamed Digital Analytics.

Utilities

The ActiveX cleanup utility (uacflchk) is no longer supplied, as it is no longer
needed.

There is a new IBM Marketing Platform utility, alertConfigTool, which registers
alerts and configurations for IBM EMM products. For details, see the IBM
Campaign Installation Guide.

Configuration

There is a new configuration property (Settings | Configuration | Campaign |
Partitions | partition[n] | dataSources | DefaultTextType) for ODBC data
sources. This property tells IBM Campaign how to create text fields in the
destination data source if the source text fields are from a different data source
type. For more information, see the IBM Campaign Administrator's Guide. (TT
DOC00628)

A new configuration property was added (Affinium | Campaign | partitions |
partition[n] | server | flowchartConfig | legacyMultifieldAudience). In most
cases, you can leave this property set to the default value of FALSE. Campaign
v8.5.0.4 and newer name multifield Audience ID fields according to the audience
definition, regardless of the source of the fields. When you configure processes to
use multifield Audience ID fields, you now see the new Audience ID naming
convention for multifield audiences. Already-configured processes in flowcharts
created in previous Campaign versions should continue to work. However, if old
flowcharts fail because of the change in the naming convention, you can revert
Campaign behavior by setting legacyMultifieldAudience=TRUE. (RTC 5219
DEF063741)

The Campaign | Server | fullContextPath property is now used to specify the
URL that Campaign flowcharts use to communicate to the application server
Listener proxy. This property is undefined by default, which causes the system to
determine the URL dynamically. When the Marketing Platform is integrated with
the IBM Tivoli® web access control platform, you must set this property to the
Campaign URL in Tivoli.

Flowcharts

Beginning with version 9.0, the flowchart workspace was redesigned to change the
look and feel and improve usability. The framework is now based on a Dojo
component, Dojo Diagrammer, instead of Active-X. ActiveX, supported only in
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Internet Explorer, requires downloading a plug-in control on the client to work
with flowcharts. Because many customers are not comfortable downloading
plug-ins, and because ActiveX will not be supported in future versions of Internet
Explorer, the Dojo component has been introduced to provide the flowchart
workspace going forward.

The redesign includes changes to the appearance of flowchart and report
components, including toolbars, dialog boxes, progress indicators, and related
controls. The overall functionality is the same.

The flowchart window looks similar to the following example:

The following list summarizes the changes:
v Separate flowchart window. When you create or edit a flowchart, a separate

flowchart window opens. Be aware of the following features of the new
flowchart window:
– When you click the flowchart tab in the main Campaign window, the main

window contains a link that says "The flowchart is open in another window.
Click here to display it." If you click the link while the flowchart window is
already open, the flowchart window is activated. If you have closed the
flowchart window, clicking this link reopens the flowchart in View mode.

– Pop-up blockers prevent the flowchart window from opening. You must turn
off any pop-up blockers in your browser or browser add-ons, or set up a
specific exception for the Campaign server.

– You can move and resize the flowchart window up to the size of your screen.
You can also work in the main Campaign window while the flowchart
window is open.

– You can have only one flowchart window open at a time. If you open or edit
a different flowchart while a flowchart is already open, the new flowchart
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will replace the current flowchart in the open window. If you have unsaved
changes in the current flowchart, you will be prompted to save them before
the new flowchart opens.

v New toolbar icons. The toolbar contains updated icons, and also contains a
number of new options to provide added control over the flowchart and its
appearance.

v Process box updates. The process boxes on the palette have updated icons to
make them easier to identify and select.
Connect process boxes by drawing a line from any of the four connection points
that are visible on the process box (left, right, top, or bottom), instead of being
restricted to the center of the process box as in the ActiveX control.

Note: Contrary to prior releases, not all process boxes and dialogs that use the
new look and feel are resizable. This is addressed in Campaign fix pack 9.1.0.2.

v Drag and drop. True drag and drop is supported, so you can drag any process
box from the palette to the workspace, instead of clicking in the workspace.

v New flowchart viewing and editing tools. The flowchart window no longer
uses the grid-based layout of the ActiveX control. Instead, you can move process
boxes freely, and place them anywhere on the flowchart. For that reason, new
tools are available to adjust flowchart appearance when a flowchart is open for
editing or viewing:
– Use the alignment options on the toolbar to align two or more selected

process boxes: Align left, Align right, Align top, Align bottom, Align center
vertical, Align center horizontal. The grid of gray dots is no longer used
because alignment options are provided.

– Use the Change Layout options on the toolbar to apply a predefined layout to
your flowchart: Tree, Org Chart, Circular, Hierarchical.

– Use Zoom In, Zoom Out, and Reset Zoom on the toolbar to improve the
visibility of portions of the flowchart. You can also use press the Control key
on your keyboard while using the scroll wheel on your mouse to zoom in
and out.

– Use Fit Contents on the toolbar to resize the flowchart to fit in the workspace.
Then, if needed, use the Zoom options or the panning box to further refine
the view.

– Use Search on the toolbar to find a process box by name in the flowchart. The
search tool is not case sensitive. When a search result is found, the matching
process box is centered in the flowchart window and highlighted. Click the
Search icon again to continue to the next match.

– Use Select All on the toolbar to select all process boxes in the flowchart.
– Use the panning box in the lower right corner of the flowchart window to

highlight the area that you want to see. Panning is especially useful in
flowcharts with many process boxes.

v Running flowcharts. The new flowchart window provides new icons for the run
states for a process box, most notably the icons indicating that the flowchart is
running, indicated by an animated icon, or paused, providing a status icon that
was not available with the ActiveX control.

v Dialog box enhancements. The dialog boxes in the flowchart, especially for
configuring process boxes, have been improved in this release. Some of the
changes include the following modifications:
– The behavior of lists in some dialogs has changed. For example, you can use

Ctrl+click to select multiple items. Lists that can be expanded are now
indicated by a small arrow next to the list, instead of a plus sign (+).
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– The appearance of process dialog boxes has been updated to improve their
usability, while keeping the layout and functionality similar to past releases.

– You no longer need to use a separate edit field to modify cell values in a grid
in process box dialogs. Double-click any cell to edit it.

v New export options. There are changes to how you export profile data after you
profile a field in a process. Previously, data was exported to XLS and the file
name was hardcoded to "Campaign.xls". Now data is exported to CSV
(comma-separated values) format. Use the File name field to assign a file name.
The default name is the dialog box title, "Export Report Data".

For information about the new and changed features, see the following topics in
the IBM Campaign User's Guide:
v Flowchart workspace overview
v Working with process boxes
v Changing flowchart appearance

To get help when a flowchart is open for editing, click the help icon 
 

in the
flowchart window toolbar.

Reports

Some changes were made to report appearance. For example, the legend at the top
of cell reports was improved to be more legible.

The Cell Waterfall report now lets you specify which path in the flowchart to
analyze, if the selected cell is connected to multiple downstream processes. Use the
Path list in the report toolbar to select a path to analyze.

Information about installing, upgrading, and configuring reports is no longer in
the IBM Campaign documentation. This information is now consolidated in a new
guide, IBM EMM Reports Installation and Configuration Guide.

Table mapping

With the replacement of the ActiveX control with a Dojo-based user interface, the
Table Mappings dialog has been updated and enhanced. The essential functionality
is the same, but the Save and Load mappings controls have been replaced by
drop-down lists, as shown in the following example:

6 IBM Campaign: Release Notes



Additional changes

The Russian language is now supported. For information about setting locale
preferences, see the IBM Marketing Platform Administrator's Guide.
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Chapter 3. Fixed defects

This section lists defects fixed in Campaign 9.0.0, sorted by defect number.

Table 1. Campaign fixed defects

Issue ID Description

DEF061871 Running session with svradm does not update user interface view in particular case.

DEF062829 Cell Size Limit not exported for Segment process boxes in .xml format.

DEF062867 Installing the Listener with the -n parameter does not install the Listener in non-recovery mode as a
Windows service.

DEF063066 The user is not able to add an offer using the offer template if the context root is configured at
multiple levels.

DEF063073 The user cannot add a cell to the TCS if the context root is set to multiple levels.

DEF063276 Some Japanese characters are not accepted by the Fix Duplicates Dialog box.

DEF063391 Incorrect error message if the translation table is not mapped and the Digital Analytics segment is
input.

DEF063408 StackOverflow displays when editing the Selectbox-String attribute of an offer from the TCS.

DEF063429 Numeric User variable accepts multiple values in its initial and current value.

DEF063533 The dictionary file is not created when writing records using the "Log to other destination" option.

DEF063596 The report type unica_acgenrpt is converted for the respective locale.

DEF063623 In French, a space is missing before the colon character.

DEF063625 The installer default locale lists Portuguese and not Brazilian Portuguese.

DEF063738 Some non-English strings appear in English user interface.

DEF063741 Error 11300 while trying to view Cell Content Report.

DEF063758 The English installer page title does not match the steps.

DEF063773 The wrong tool tip for Start Time/End Time columns displays on the All Monitored Runs page.

DEF063848 The user cannot launch aclsnr after configuring Campaign system table manually.

DEF063880 unica_acclean does not delete files when the file name exceeds 200 characters.

DEF063892 Campaign, Attribution Modeler, and Interaction History cannot be uninstalled in console mode.

DEF063939 unica_acsesutil cannot recompute the count of mapped flat files.

DEF064011 Errors occur on the "Campaign Setting" page using Internet Explorer 8.

DEF064012 Function failed with illegal pattern character 'j error in the French language.
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Chapter 4. Known issues

Campaign 9.0.0 includes the following known issues, sorted by defect number.

Table 2. Campaign known issues

Issue Issue ID Description

Message when running
installer in UNIX console
mode

NA When running the installer in UNIX console mode, an
informational message indicates that the installer .bin file
was not found. You can ignore this message.

Unable to open flowcharts
after migrating non-ASCII
data

NA After migrating non-ASCII data to Campaign 8.6, in some
cases you cannot open Campaign flowcharts on the target
system. Session flowcharts open successfully. To work around
this issue, remigrate the campaigns in overwrite mode. You
can then open the flowcharts.

UA_UsrResponseType.Name
field cannot contain
restricted string

NA The UA_UsrResponseType.Name field cannot contain a left
parenthesis followed by a single quote.

Use unique TempTablePrefix
for each data source when
mapping multiple data
sources to same physical
database

NA If you mapped multiple data sources in Campaign to the
same physical database, and you use the same
TempTablePrefix for more than one of the data sources, when
you use the cleanup utility to delete orphaned temp tables, it
may falsely identify temp tables as orphaned, when they are
in fact legitimate temp tables defined from a different
Campaign data source.

Any deleted temp tables will automatically be recreated when
you rerun affected flowcharts, but as a best practice, use a
unique TempTablePrefix for each data source when mapping
multiple data sources to the same physical database. If the
data sources defined in Campaign map to different schemas
in the database, another solution is to ensure that the
database user who runs the cleanup utility does not have
privileges to drop tables in other schemas in the same
database.

Profile window Usability
issues

DEF02440 In certain instances, the grid border lines are distorted.

Hot keys are not
implemented on most of the
windows

DEF02968 In the Dojo implementation it is not possible to use keyboard
shortcuts to activate certain functions. Instead the user must
click buttons.

Connections between
process boxes may overlap
when user switches from
horizontal to vertical mode

DEF02980 When users switch between horizontal and vertical view
modes, the connection lines and processes may overlap.

The word "OK" is not
translated

DEF04635, DEF04636,
DEF05103, DEF07619

The word "OK" is not translated in error and verification
messages.

Segment name can be kept
blank. The validation/error
that was present in active-x
is missing

DEF05621 During segment creation, a blank name for a segment can be
provided. However, the segment process cannot be saved
with a blank name.
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Table 2. Campaign known issues (continued)

Issue Issue ID Description

Caching in DOJO displays
the wrong information until
the process box information
is completely loaded

DEF06141 Until a process box loads completely, previous information,
or information pertaining to the previous process box
displays in the background. When the loading of all data is
done, the screen is refreshed and shows the most up to date
data.

Grid borders are not
displayed wherever data is
not present.

DEF06692 In certain process boxes, if no data is present in a grid
column, the borders around the cell in the grid are not
displayed.

If contact date is year 2050
then the Optimize process
box shows error 10404:
unable to communicate with
server process; server
process might have exited.

DEF06910 Contact date cannot be later than 2037.

Custom Cell Attributes node
is displayed under IBM
Campaign Generated Fields
in session Flowchart

DEF07255 Since the target cell spreadsheet is not available in the
sessions, the "Custom Cell Attributes" node should not be
available under IBM Campaign Generated Fields in session
Flowchart.

Extract shows "Process run
results will be lost" after
clicking OK, even if no
configurations are changed.

DEF07685 After upgrade, Extract shows "Process run results will be
lost" after clicking OK, even if no configurations are changed.
It also shows the same message when templates from an
earlier version are used after upgrade.

Incorrect report displayed
for cells which have not yet
run

DEF07844 For cells which have not yet run, the report for the previous
cell displays.

The server might crash
when running the Collect
Flowchart data functionality

DEF08019 If a text value is entered in the date field on the Collect
Flowchart data functionality, the server process might crash.

User cannot see complete
3D Graph in the report
window

DEF08036 Due to maximization limits on the report window, the entire
3D report cannot be shown in one window without scrolling.

Process boxes overlap on
flowchart window

DEF08603 In certain scenarios, processes might overlap one another.

A deleted flowchart tab
might continue to display

DEF08955 A deleted flowchart tab displays until the campaign or
session is revisited again in a specific condition.

The Offer and Control-Cell
columns for Control Cells
do not display as disabled
on the Treatment Tab of the
Mail List.

DEF09163 On the treatment tab of the Maillist or Calllist process,
columns related to the Control cells and related offers are not
greyed-out. You cannot add offers for control cells, so the
columns should be disabled.

Upgrade does not put
correct information in
setenv.bat for Marketing
Platform

DEF09359 When running the Campaign upgrade scripts, there is a
pointer in "setenv.bat" to the platform home directory.
UNICA_PLATFORM_HOME must be set to run acUpgradeTool. If it
is not set, the user is prompted to provide the path while
running the tool.

If the Marketing Platform is installed on a different machine
from Campaign, the path of platform home is not accessible
to the upgrade tool. To continue, the user must enter another
accessible path for platform home. This can be in any
directory.
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Table 2. Campaign known issues (continued)

Issue Issue ID Description

Cutom Macro is not moved
to other folder if it is
simultaneously accessed and
edited by other user

DEF09713 Unexpected behavior can occur when multiple users access
the same custom macro simultaneously.

The Maillist process box
user interface might be
distorted if an offer has a
long name

DEF10023 If an offer with a long name is assigned in Maillist List
process box, then the Maillist process box drop-down might
get distorted.

Export Crosstab Report to
Excel generates an Internet
Explorer error

DEF010889 Error occurs when a Campaign Crosstab report with a large
number of Bins processes data that contains a large number
of unique values. Workaround is to use a smaller number of
Bins.

Summary file option in
Maillist should be disabled
when Export to File is
unchecked.

DEF011416 When the Export to File option is unchecked on the
Fulfillment tab of Maillist process box, a Summary File option
is enabled, if user provides a summary file name and
executes a flowchart, the Summary File is not created at
desired location.

Error bound is not
calculated after changing
sample size on sample size
calculation

DEF011478 The error bound is not calculated or displayed after changing
sample size and clicking Compute error bound. The previous
value of the error bound persists

Date format in Campaign
Generated Fields always
show US date format

DEF15427, INC13930,
INC14653, INC18663

Date formats of Campaign Generated Fields in non-US
locales always show in MM/DD/YYYY format.

Ownership change of a
campaign or session can
cause interactive flowchart
and interactive session to
fail.

DEF055155, INC65294 Changing the ownership of a campaign or session can cause
the associated interactive flowchart and interactive session to
fail.

Information related to
associated products does not
appear in offer on
Marketing Operations side

DEF062333 When an offer created in Campaign with products associated
with it is imported in Marketing Operations, information
about the associated products is not available in Marketing
Operations.

Inconsistent error message
about Campaign custom
attribute format

DEF062527 The error message "Invalid Data Format attribute_name" for
the wrong data format of a Campaign custom attribute
should indicate what format is supported by the custom
attribute.

The flowchart schedule fails
if the flowchart is renamed
or moved and it has one
schedule completed.

DEF062623 The flowchart schedule fails with Error 701.

Response process box failure
with a derived field
assigned to a Response
Date, for DB2®.

DEF062846 When system tables are in DB2, the Response process fails to
run if the Response Date is set to a derived field that returns
a Date (but not a DateTime).

If it was not mapped
initially, theDigital Analytics
translation table is not
available in the Segment
process box.

DEF063392 No translation table or any other user table is available in the
Segment process box, if the translation table was not mapped
initially.
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Table 2. Campaign known issues (continued)

Issue Issue ID Description

StackOverflow occurs when
trying to edit the
Selectbox-String attribute of
an offer from TCS.

DEF063408 Create an offer that includes a custom attribute of Type Select
String Box, which allows addition of list items from within
edit forms. In the campaign Target Cell Spreadsheet (TCS),
assign the offer to a cell. If you try to add or remove values,
a "StackOverflow" occurs.

Numeric user variables
accept multiple values in
initial and current value.

DEF063429 Numeric user variables display incorrect values when
multiple values are selected or entered for initial or current
value (all values are appended). The workaround is to select
or enter only a single value.

Unimportant upgrade log
messages.

DEF063452
(DOC00681)

If you migrate from 6.4 to any version of 7.x through 8.5,
then upgrade to 8.6, and "'creative URL" with id 15 exists in
the UA_AttributeDef table, then the ac_upgrade.log records
the following messages: "WARN
upgradeTool.ACMigSysDBUpgradeTask [212] - SQL updated
failed: Violation of PRIMARY KEY constraint
'PK__UA_AttributeDef__0519C6AF'. Cannot insert duplicate
key in object 'dbo.UA_AttributeDef'. ERROR
upgradeTool.ACMigSysDBUpgradeTask [82] - Error in
execution of database upgrade task." You can ignore these
messages.

Unable to edit asset
attached to an offer through
Campaign TCS, using
CreativeURL.

DEF063496 Create an offer from Campaign using an asset attached with
the Creative URL attribute. Create a campaign and in Target
Cells and a Cell assign the offer to it. In the Assigned Offers
column, click the offer, then preview and edit it. Click Browse
Library and click anywhere in the window. "Stack Overflow
at line :0" is displayed.

Error 5000 when clicking the
My Asset link, using
CreativeURL.

DEF063499 This error occurs when an asset is attached to an offer created
from Campaign. Create an offer template with a Creative
URL attribute and attach an asset by clicking Browse Library.
Create an offer based on the template. Under the Creative
URL attribute, click Browse, click an asset, and click the "My
Asset" link. An error occurs.

Model process returns
Error:14016 for non-English
users.

DEF063521 The Model process in a flowchart fails to run if All
Algorithms is selected by a user whose Platform language
preference is non-English.

Dictionary file is not created
if some cells are selected for
"log to other destination".

DEF063533 Write records using "Log to other destination", select cells
using "Select cell" button, and write to a "Flat File with data
dictionary". The flowchart runs successfully but creates only a
.dat file. The dictionary file (.dct) is not created.
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Chapter 5. Known limitations

Campaign 9.0.0 includes the following known limitations.

Table 3. Campaign known limitations

Issue Number Description

Dialog boxes cannot be
resized

NA You cannot maximize or resize dialog boxes in Campaign (for
example Process Configuration or Table Mapping dialogs).

The default value for a
custom cell attribute does
not appear when you open
the Target Cell Spreadsheet.

NA Although the default value is not initially displayed, it will
be used. The value can be displayed or changed by clicking
or opening and editing the custom cell attribute in the TCS.

Profiling a Campaign
Generated Field (UCGF)
does not yield correct
results.

NA Some UCGFs have a value according to the cell or the offer
being processed. For cell-related UCGFs, only the value
associated with the first cell appears during profiling.

CreativeURL upgrade
scenarios for older
installations of Campaign

NA The CreativeURL attribute was introduced in v6.4,
discontinued in v7.x, and reintroduced in v8.6. If you migrate
from 6.4 to any version of 7.x through 8.5, and then upgrade
to 9.0, there are two attributes in 9.0: ACx_CreativeURL and
CreativeURL. Only the new CreativeURL attribute should be
used. ACx_CreativeURL is retained only as a text attribute and
does not provide CreativeURL functionality.

UA_UsrResponseType Name
field cannot contain
restricted string

NA The UA_UsrResponseType.Name field cannot contain the string
" ('" (which is <space><left parenthesis><single quote>)

Use unique TempTablePrefix
for each data source when
mapping multiple data
sources to same physical
database

NA If you mapped multiple data sources in Campaign to the
same physical database, and you use the same
TempTablePrefix for more than one of the data sources, when
you use the cleanup utility to delete orphaned temp tables, it
may falsely identify temp tables as orphaned, when they are
in fact legitimate temp tables defined from a different
Campaign data source.

Any deleted temp tables will automatically be recreated when
you rerun affected flowcharts, but as a best practice, use a
unique TempTablePrefix for each data source when mapping
multiple data sources to the same physical database.

If the data sources defined in Campaign map to different
schemas in the database, another solution is to ensure that
the database user who runs the cleanup utility does not have
privileges to drop tables in other schemas in the same
database.

WebLogic 11g and AIX® 6.1
or higher

NA If you use the combination of WebLogic 11g and AIX 6.1 or
higher, a manual workaround is required to address
classloading issues in WebLogic. The workaround involves
removing the xercesImpl.jar file from the Campaign.war file,
and repackaging it before deploying. Full details are included
in the installation steps in the Campaign 9.0.0 Installation
Guide.
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Table 3. Campaign known limitations (continued)

Issue Number Description

Folders without any Custom
Macros are displayed under
the "Custom Macro" node in
the Formula Helper window

DEF03203 If folders exist on a parent folder, and these folders contain
no custom macros, Campaign still displays the folder.

List of Custom Macro
Folder is not sorted in
alphabetical order

DEF04175 When creating a new folder, the parent window of custom
macros isn't refreshed. Therefore, the new folder appears at
the bottom of the list of folders, instead of in alphabetical
order. Refreshing restores alphabetical order.

Selected derived field under
Based on drop-down of
advanced setting window
should open in Edit mode

DEF09055 When clicking the button to see the details of a derived field
added on the MORE section, the derived field should open in
edit mode. Instead a Create Derived Field window opens.
Users can select the derived field from the drop-down.

Campaign outputs an
unparsable delimited file
under some circumstances

DEF011010 When writing output to a delimited file, if the output
contains any values that include both the delimiter and
qualifier characters, the resulting output file is invalid
(unparsable).

CURRENT_DATE macro
always includes the time
component even if a format
is specified

DEF041474 For all supported databases, Campaign attempts to run the
CURRENT_DATE macro in the database using a
database-supported current time SQL call (for example,
SYSDATE, GETDATE, DATE, or TODAY). In these cases, all
parameters (including the format of the date) of this macro
function are ignored and the output includes whatever is
returned by the database (e.g., a time component may be
included in the output).

If this occurs and you want to return just the date or the date
in a different format, you can write your own custom macro
using raw SQL or use otherIBM macros. For example:
DATE_STRING(CURRENT_JULIAN( ), ...)

In some cases, the CURRENT_DATE macro is run on the
Campaign server (for example, if running against a flat file,
against a non-recommended database with no equivalent
SQL support, or if the Campaign macro expression cannot be
resolved in the database). In these cases, all parameters are
recognized and the output is returned in the selected format.

Multi-field audience levels
from IBM CustomerInsight
must be configured in
Campaign to function with
CustomerInsight visual
selection

DEF042248 IBM CustomerInsight supports only secondary audience
levels that are defined with a single audience key field. Any
multi-key audience levels are ignored for secondary audience
levels, though they may be used for the primary audience
level of an EasySet. If you want to use a multi-field audience
level for analysis as a secondary audience level, you must
combine the fields into a single unique identifier with an
associated audience level definition.

Process box performance
degrades on Internet
Explorer 8

DEF04879 Campaign 9.0.0 no longer supports Internet Explorer 8 due to
JavaScript-related limitations.
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Table 3. Campaign known limitations (continued)

Issue Number Description

Mapped table names with
non-ASCII characters in DB2
and Oracle

DEF051097 In Campaign environments with DB2 or Oracle databases,
when creating a new mapped table in a process
configuration, the following conditions cause Campaign to
produce an error when you run the process:

v If the table name you specify contains a combination of
lowercase and non-ASCII characters.

v If any data source properties that append a prefix to the
table name (for example, TempTablePrefix) contain a
combination of lowercase and non-ASCII characters.

IBM Generated Fields in
raw SQL not supported for
Segment process

DEF052919 IBM generated fields are not available in the Segment
process, therefore generated fields in raw SQL are also not
supported in the Segment process.

Response process fails to
execute when
TempTablePool=True and
TruncateSQL is set

DEF052937 TempTablePool is not supported for DB2 system tables and
should be set to FALSE for system tables in DB2.

Error profiling dimension
tables in a process that takes
output from an unexecuted
Extract process

DEF053929 Error 1130 occurs on trying to profile fields of a dimension
table mapped in an Extract process, and available as a join in
a subsequent process, if the Extract process has been
configured but not executed. To work around this issue, run
the Extract process before profiling fields in subsequent
processes.

Non-existent or deactivated
user IDs can be specified as
the owners for objects

DEF053932,
DEF053933

Non-existent or deactivated user IDs can be specified as the
owners for objects, using the CHANGEOWNER syntax in
unica_svradm.

Set autocommit to "true" on
system table databases, if
running ac_populate scripts
manually

DEF058955 Due to changes in how the ac_populate scripts work, you
must set auto-commit to true in your database settings. This
is required only if you run the scripts manually following
installation. For some databases, "true" may be the default
setting, but you should verify the setting before installing
your IBM products. See your database documentation for
instructions on setting this value.

Campaign utilities 161323 The error "Login failed. Error 10553" can occur if you try to
log in to the Campaign utilities when the IBM Marketing
Platform | Security | login method is set to Windows
integrated login or Web access control. To avoid this issue,
change the login type to LDAP or IBM Marketing Platform
prior to using the Campaign utilities.

Process box connection
arrow changes direction

201968, 200241 If two process boxes are moved very close together in a
flowchart, the direction of the connection arrow changes. This
limitation affects the visual representation of the arrow. The
process data flow is not affected. The workaround is to move
the process boxes farther apart so the arrowhead changes
back to the correct direction.
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Chapter 6. Campaign Reports Package

The Campaign Reports Package delivers reporting schemas that you can use to
track campaign, offer, and cell performance.

To use the Reports Package, Campaign must be integrated with IBM Cognos®.

The Campaign Reports Package contains the following items:
v Schemas that are registered with Marketing Platform during installation. They

describe the attributes and metrics that represent the product's reporting schema
and include:
– Base schemas that are the basis of the reporting schema (with no custom

attributes)
– Custom versions of most of the base schemas that rely on the preconfigured

custom attributes for Campaign
– Templates that you can use to create new schemas

v IBM Cognos customizable model and reports to be deployed on an IBM Cognos
BI Server

v Reference documentation that describes the IBM Cognos model and the reports.
Documentation can be found in the directory ReportsPackCampaign\cognos10\
CampaignDocs.

The Campaign reports retrieve data from one data source: the Campaign system
tables.

Reporting Schemas

The following reporting schemas are provided:
v Campaign Views provides the standard attribute views of the Campaign system

tables (campaign, offer, cell, and so on).
v Campaign Custom Attributes is for reporting on custom attributes of campaigns,

offers, and cells.
v Campaign Performance is used by reports that display performance

measurements starting at the campaign level over all time or various periods of
time (days, months, and so on).

v Offer Performance is used by reports that display performance measurements
starting at the offer level over all time or various periods of time (days, months,
and so on).

v Campaign Offer Response Breakout is used by reports that show campaign and
offer responses based on response types.

v Campaign Offer Contact Status Breakout is used for measurement of campaign
and offer contacts based on contact status.

The custom schemas extend the last five of the listed schemas to include the
default, preconfigured response types, custom attributes, and so on.

Templates

If you have additional audience levels, you can create additional reporting schemas
for them with the following templates:
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v Campaign Views
v Campaign Custom Attributes
v Campaign Performance
v Offer Performance
v Campaign Offer Response Breakout
v Campaign Offer Contact Status Breakout

Reports

The reports package contains Cognos example reports that can be accessed from
the Analytics menu or the Analysis tab for a campaign or offer. Reports can also be
displayed in portlets on the Dashboard.

The following campaign-specific example reports are available from the Campaign
Analysis tab:
v Campaign Detailed Offer Response Breakout
v Campaign Financial Summary by Offer (Actual)
v Campaign Offer Performance by Month
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell with Revenue
v Campaign Performance Summary by Offer
v Campaign Performance Summary by Cell and Offer
v Campaign Performance Summary by Cell and Offer (with Revenue)

The following offer example reports are available from the Offer Analysis tab:
v "What If" Offer Financial Summary
v Offer Performance by Day
v Offer Performance Summary by Campaign

The following cross-object example reports include information about multiple
objects in Campaign. These reports are available from the Campaign Analytics
page.
v "What If" Offer Financial Summary
v Campaign Detailed Offer Response Breakout
v Campaign Financial Summary by Offer (Actual)
v Campaign Offer Performance by Month
v Campaign Performance Comparison
v Campaign Performance Comparison (with Revenue)
v Campaign Performance Comparison by Initiative
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell (with Revenue)
v Campaign Performance Summary by Cell by Initiative
v Campaign Performance Summary by Offer
v Campaign Performance Summary by Offer (with Revenue)
v Campaign Performance Summary by Cell and Offer
v Campaign Performance Summary by Cell and Offer (with Revenue)
v Campaign Summary
v Offer Campaign Listings

20 IBM Campaign: Release Notes



v Offer Performance by Day
v Offer Performance Comparison
v Offer Performance Metrics
v Offer Performance Summary by Campaign

The following campaign-specific example report portlets are available on
dashboard pages:
v Campaign Response Rate Comparison
v Campaign Return on Investment Comparison
v Campaign Revenue Comparison by Offer
v Offer Response Breakout
v Offer Response Rate Comparison
v Offer Responses for Last 7 Days

Known issues in the Campaign Reports Package
This section lists known issues in the IBM Campaign Reports Package version
9.0.0, sorted by defect number.

Table 4. Campaign Reports Package known issues

Issue ID Description

Additional legend item
displayed on Offer
Performance by Day
dashboard report

DEF044226 On the Offer Performance by Day dashboard portlet report,
an additional, unlabeled item appears in the legend when the
report contains dates with no corresponding offers.

Reports folder permissions
are synchronized for
multiple partitions

DEF045222 When a Campaign administrator attempts to synchronize
reports folder permissions for a single partition in a
multi-partition Campaign environment, the synchronization
occurs across all partitions, even if there is a separate
ReportSystem role for each partition.
Note: The synchronization of folders that do not belong to
the current partition does not cause authorization problems.

Offer Performance Summary
by Campaign shows extra
row

DEF047315,
DEF047336

The Offer Performance Summary by Campaign report shows
an extra row with values displayed as 0.

Offer Performance Summary
by Campaign displays offers
with no contact or response
history

DEF047336,
DEF047315

The Offer Performance Summary by Campaign report
displays offers that are assigned to a campaign even though
no contact history or response history data exist for those
offers in the campaign.

Offer Performance
Comparison displays offers
with no contact history

DEF047745 The Offer Performance Comparison report displays offers
that have no associated contact history.

Unnecessary row is added
to reports when response
history is not populated.

DEF062120 If you populate only the contact history in a campaign, the
following reports include an empty row: Campaign
Performance Comparison by Cell and Offer; Campaign
Performance Comparison by Cell and Offer (with Revenue).
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Contacting IBM technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company's designated support contact can log a call with
IBM technical support. To ensure that your problem is resolved efficiently and
successfully, you collect information before you log your call.

If you are not a designated support contact at your company, contact your IBM
administrator for information.

Information to gather

Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages that you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM technical support, you might be asked to provide information
about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your IBM
applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, you can obtain the version number of any IBM application by viewing
the version.txt file that is located under the installation directory for each
application.

Contact information for IBM technical support

For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.ibm.com/support/entry/portal/open_service_request).

Note: To enter a support request, you must log in with an IBM account. If
possible, this account must be linked to your IBM customer number. To learn more
about associating your account with your IBM customer number, see Support
Resources > Entitled Software Support on the Support Portal.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information about the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

© Copyright IBM Corp. 1998, 2015 25



IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations
IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."
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